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Introduction

This Rational ProjectConsole tutorial has a modular design so that you can complete or skip sections, depending on your role in your project and your interest in the various data sources. This section of the tutorial shows you how to use a data transformation to obtain derived defect data that are not directly available through data collection. 
This section includes introductory information to help you understand transformations in general, and to provide an overview of the data transformation process. The exercises in this section show you how to collect the raw data to be transformed, create a Perl transformation script, test the transformation script, review the results of the test, and, finally, specify the transformation as the shutdown command for a collection task. 

PC setup

For information about installing Rational ProjectConsole product, see Section 0 – Setting Up for the Tutorial. 

The instructions in this section assume that you have installed the Rational ProjectConsole repository using Microsoft SQL Server 2000.  SQL commands are executed using the Microsoft SQL Server Analyzer and the SQL command-line tool.  If you are using a different database tool, see the documentation for that tool guide for tools similar to Microsoft SQL Server.

For this section, it is assumed that you have created the following two Rational ProjectConsole databases in SQL Server (see Section 0 – Setting Up for the Tutorial):

· tutorialmaster

· tutorialwarehouse

Notes

· The graphics used to illustrate the Microsoft Word user interface were captured using Microsoft Word 2002. Depending on the version of Word you use, these illlustrations may look somewhat different.

· In this section, the term InstallDir refers to the installation path for Rational ProjectConsole (C:\Program Files\Rational\ProjectConsole is the default path).

Data transformations

Data transformation prerequisites

Rational ProjectConsole transformation programming requires that you have some knowledge of SQL programming, Perl or VB Script programming, and Rational ClearQuest API programming.  Without this knowledge, you may find this section difficult to follow.

Data transformations explained

Rational ProjectConsole supports data transformations.  Data transformation serves two purposes.  One, you can use data transformations  to cleanse data.  Two, you can use data transformations to perform calculations that result in derived measures, which is the subject of this section.

Data cleansing is the process of checking data for adherence to standards, consistency, and integrity.  For example, you might collect user names for a particular person, Terry Jones, for example, from several different sources.   From one source, you collect the value tjones; from another source, the value is terryj, and from a third, terry_jones.  All these values represent the same person, so you want to consolidate them into one value– tjones- using data transformation.
Derived measures are measures that are not directly available through simple Rational ProjectConsole data collections.  They must be derived.  Examples of derived measures include standard deviations, total lines of code in source files, and earned values.  

To define a data transformation, you create a raw SQL script or Rational ClearQuest Perl or VB script that you can then run as a startup or shutdown command in a Rational ProjectConsole scheduled collection task.

In this section, you’ll learn how to create a Rational ClearQuest Perl transformation script to derive additional measures from collected data. 

Note  The Rational ClearQuest API definition and general usage are outside of the scope of this tutorial.  For more information about the Rational ClearQuest API, see the Rational ClearQuest documentation.

Rational ProjectConsole target table schema

Before programming a transformation, you need to understand how Rational ProjectConsole manages its schema target tables, table names, and field names.  You will also find it useful to know something about how the Rational ProjectConsole underlying database is designed.

Rational ProjectConsole table and field names

When you use the Rational ProjectConsole Designer to create the target tables and fields to store your collected data, you define logical tables and fields.  Rational ProjectConsole uses Rational ClearQuest as its underlying database repository.  This means that when you save your changes, the tables and fields are created as Rational ClearQuest record types and record fields.  Rational ClearQuest then saves the record types and fields as physical tables and fields in the database.

To better understand the logical (Rational ClearQuest and Rational ProjectConsole) tables and fields versus physical database tables and fields, consider how Rational ClearQuest manages its names.  When you use Rational ClearQuest Designer to create a record type in Rational ClearQuest, you give the record type a name.  When you commit the new record type, Rational ClearQuest creates a database table for it.  You can change the Rational ClearQuest name for the record type, which is the name you see when you run the Rational ClearQuest Designer or Rational ClearQuest client, but the physical table name never changes.  This is also true for Rational ClearQuest record field names. The name in the actual database table does not change, even if you change the Rational ClearQuest name for the field.

Rational ProjectConsole manages logical names in much the same way as Rational ClearQuest manages its names.  You use the Rational ProjectConsole Designer to create target tables and fields and give them names.  When you commit the changes, Rational ProjectConsole asks Rational ClearQuest to create record types and fields for each new target table and field.  You can change the Rational ProjectConsole logical table and field names, but the Rational ClearQuest physical names for the record types and fields do not change.

Understanding how these names are managed is important because when you program your Rational ProjectConsole transformations, you will use the Rational ClearQuest API or raw SQL commands to extract or update the Rational ProjectConsole tables.  This requires that you pass the Rational ProjectConsole names to your Rational ClearQuest API class, or the physical database names to your raw SQL commands.

Logical schema model

You used the Designer to create the target measure tables and target dimension tables. Dimension tables are related to measure tables in that dimension tables hold denormalized values of measure attributes.  For example, if you are collecting defects, the measure is “number of defects.”  The dimensions (attributes) for the “number of defects” measure are state, priority, severity, owner, collection date, submit date, and so on.  A state can have a value of Submitted, Assigned, Opened, Resolved, or Closed.  Figure 1 shows the logical model for the target table schema you are designing.

To create each logical target dimension table, you specified the table name and defined a single field to hold the dimension values.

To create each logical time dimension table, you only specified the table name.  The time dimension table fields were defined for you.

To create the logical measure table, you specified the table name, defined the measure fields (integer or float), and defined the reference fields to the related dimension tables.
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Figure 1: Logical target table schema model
Figure 2 shows an example of a defined logical target table schema called ‘defect measure.’
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Figure 2: Sample defect measure/dimension logical target table schema
Physical Table Schema

After you commit your Rational ProjectConsole target table changes, Rational ClearQuest creates a physical schema (see Figure 3).  The important thing to remember in the physical schema is the Rational ClearQuest concept of ‘dbid’ and references.  Each table Rational ClearQuest creates contains a ‘dbid’ field or column.  The dbid is a unique identifier for every row inserted into the table.  Rational ClearQuest manages the dbid values. 
You must never insert a new row without a unique dbid value.  Thus, the references in the target measure tables are not true database foreign key references. Rather, they are dbid values.  For example, in the defect measure table, the project_fk reference field contains dbid references from the project_dim table’s dbid field.  Thus, if the project name ‘Classics POS’ has a dbid value of 3456789, then a collected defect with the project name ‘Classics POS’ will have a project_fk value of 3456789.
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Figure 3: Physical target table schema model
Figure 4 shows an example of the physical schema for the defect measure schema.
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Figure 4: Sample defect measure/dimension physical target table schema
Sample SQL queries

The following sample queries are based on the sample defect measure/dimension target table schema shown in Figure 4:

To return all of the rows in the defect table:

SELECT * FROM defect

To return all of the rows in the project dimension table:

SELECT * FROM project_dim

To return the dbid for the project value ‘Webshop’:

SELECT dbid FROM project_dim WHERE project = ‘Webshop’

To return all of the rows in the defect table that reference project ‘Webshop’:

SELECT defect.* FROM defect, project_dim

WHERE project.dim.project = ‘Webshop’ and defect .project_fk = project_dim.dbid

To return the dbids in the defect table that reference project ‘Webshop’:

SELECT defect.dbid FROM defect, project_dim

WHERE project_dim.project = ‘Webshop’ and defect.project_fk = project_dim.dbid

To return the dbids in the defect table that reference project ‘Webshop’ and have state ‘Opened’

SELECT defect.dbid FROM defect, project_dim, state_dim

WHERE project.dim.project = ‘Webshop’ and defect .project_fk = project_dim.dbid and state_dim.state = ‘Opened’ and defect.state_fk = state_dim.dbid

Derived measures 

Rational ProjectConsole can collect many measures.  However, not all of the metric charts and indicators can be created directly from the raw collected data.   Some measures must be derived.  Examples of derived measures include the following:

1. Number of defects open for 15 or fewer days, 16-30 days, 31-45 days, 46-60 days, 61-90 days, more than 90 days
2. Number of defects per 1000 lines-of-code (KSLOC)

3. Average number of defects per KSLOC

4. Earned value

These are just a few examples of the many derived measures that can be calculated.

For this tutorial section, you’ll develop a solution for the first example – determining the number of defects open for several different time intervals. This example will help you become familiar with defining transformations using the Rational ClearQuest API and other tools that Rational ProjectConsole provides for this purpose.

Derived attribute or derived measure?

Before you make changes to the data warehouse, you must determine what your new measure really is.   Is it a derived measure (integer or float value), or is it a derived attribute of an existing measure?   
In this exercise, you want to show the number of defects that have been open for 15 days or fewer, 16-30 days, 31-45 days, 46-60 days, 61-90 days, and more than 90 days.  So, what do the time intervals <15 days, 16-30 days, 31-45 days represent?   These intervals are not really measures.  Rather, a time interval is an attribute of a (defect) measure.  A defect can have a “Days Open” attribute value of “<15 days,” “16-30 days”, and so on. So, we can conclude that your transformation will process all collected defects and determine the “Days Open” derived attribute value for each defect.

The next question is, how do you determine the number of days a defect has been open?  The solution is simple.  A defect has a submit date.  During a defect collection, if the defect state is ‘open,’ then the number of days that the defect has been open is the difference between the collection date and the submit date.   
Note  For the exercises in this section, you’ll define ‘open’ defects as those defects in the ‘Assigned,’ ‘Open,’ and ‘Resolved’ states.  ‘Submitted’ is not an open state because it has not yet been classified as a defect.   A ‘Resolved’ defect is still ‘open’ because ‘resolved’ means that development has provided a fix, but Quality Engineering has not verified it.

Defining a data transformation using Rational ClearQuest API

Part 1 –  Checking existing data

In this tutorial, you will use the sample defect_measure table, the sample defect_sourceTemplate, the sample defect_mapping and the sample defect_collection.

The transformation you will create requires:

· Collection of the SubmitDate defect
· A DaysOpen field in the defect_measure table to store the number of days open that the transformation will calculate
The sample defect_sourceTemplate has a SubmitDate source field. This table needs no modification.

Because the sample defect_measure table has a field that references the SubmitDate time dimension table and a field that references the DaysOpen_Dim dimension table, this table requires no changes.

Every time that you create a transformation script, you must first ensure that the source template is set up to extract the right data and that the target tables in the data warehouse contain target fields for this data, in addition to the calculated data.

Part 2 –   Running the collection task

In this exercise, you will use the Rational ProjectConsole Designer to run the defect_collection task. Later, when you test your transformation script you will have this data in the warehouse to update.
	
	Use case steps
	Details
	Display

	17.2.1 
	Log in to the Rational ProjectConsole Web site.  

Note You can log in from the Rational ProjectConsole server or from a client.
	Start your Web browser, and type the following URL:

http://server_machine/projectconsole

where server_machine is the name of your Rational ProjectConsole Web server.
	

	17.2.2 
	Rational ProjectConsole is the team Web site. You can bookmark it in your browser and when you go there, log in to identify yourself.
	In the Username box, type “admin.”

In the Password box, type “changeit.”

Click Log In.
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	17.2.3 
	
	The start page for the sample application ClassicsCD.com is in the artifact frame on the right. 

In the left frame, is the Rational ProjectConsole navigation tree. 
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	17.2.4 
	Open the Rational ProjectConsole Designer.
	On the Rational ProjectConsole Operations toolbar, click Designer.
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	17.2.5 
	
	The Designer starts in a new browser window.
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	17.2.6 
	Open the defect_collection [Task] window.
	In the navigation tree, expand Scheduled Tasks, and then click defect_collection.
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	17.2.7 
	Run the collection task.
	Click Task > Run.
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	17.2.8 
	Acknowledge the start of the collection task run on your server.
	The Designer displays a Task Scheduler window that lets you know the collection task run was started on your Rational ProjectConsole server.

Click OK.
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	17.2.9 
	Check to see if the task ran successfully.
	In the Designer navigation tree, expand Scheduled Task Logs, and then click defect_collection_<date/time stamp>.

.

If the collection ran successfully, the Status box displays SUCCESS.
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Part 3 –  Creating a transformation

In this exercise, you will define a data transformation that calculates the number of days a defect has been open.   

	
	Use Case Steps
	Details
	Display

	17.3.1 
	Open a command window in the InstallDir\bin directory.
	From your desktop, click Start > Programs > Accessories > Command Prompt.

At the prompt, type the following command:

cd program files\rational\projectconsole\bin
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	17.3.2 
	Copy a Perl transformation script template that you can use as the basis for your own Perl transformation script.
	At the prompt, type the following command:

copy transformationTemplate.pl calcDaysOpen.pl

The transformationTemplate.pl Perl script provides a starting point for developing Rational ProjectConsole transformation scripts that use the Rational ClearQuest API. The script performs a session login and initializes the PjCLib module for you.

Note  You can also find a copy of the final transformation script in the InstallDir\bin.  The file name is calculateDaysOpen.pl.”  
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	17.3.3 
	Edit the Perl transformation script.
	At the prompt, type the following command:

Notepad calcDaysOpen.pl

You will add your transformation code in the myMain subroutine where you see the comment, “Your transformation code goes here.”

Delete the sample code.
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	17.3.4 
	Because the Perl script you are creating will execute some SQL statements, the physical table and field names are needed.

Declare constant variables for the logical tables that the collection will access.
	Start your transformation by declaring constant variables for the logical table names that the collection will access.  These constant variables will hold the physical names for the tables and fields.   

Remember that when you use SQL statements, you must use the physical table and field names.

Assign each constant variable the physical table name by calling the following translation subroutine: 

PjCLib-> getPhysicalTableDbName();

passing in the logical table name.  
You will reference the following tables in the transformation:

· DaysOpen_Dim

· state_dim

· SubmitDate

· defect_measure

· collectiondate

Note  The table names are case-sensitive. Type the names exactly as you see them in the Designer.
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	17.3.5 
	Declare constant variables for the logical fields to be accessed.
	Add constant variables for the logical field that will be accessed.  These constant variables will hold the translated physical field names.   

Assign each constant variable the physical field name by calling the following translation subroutine:

PjCLib-> getPhysicalFieldDbName ();

passing in the logical table names and field names.  You will reference the following fields in the transformation:

Logical Table Name

Logical Field Name

defect_measure

DaysOpen_fk

defect_measure

collectiondate_fk

defect_measure

SubmitDate_fk

defect_measure

state_fk

DaysOpen_Dim

Days Open

SubmitDate

SubmitDate_name

SubmitDate

SubmitDate_daynum

collectiondate

collectiondate_name

state_dim

state

Note  The table and field names are case-sensitive.  Type the names exactly as you see them in the Designer.

Alternatively, copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.
	    $DAYSOPEN_FK = PjCLib->getPhysicalFieldDbName("defect_measure", "DaysOpen_fk");

    $COLLECTIONDATE_FK = PjCLib->getPhysicalFieldDbName("defect_measure", "collectiondate_fk");

    $SUBMITDATE_FK = PjCLib->getPhysicalFieldDbName("defect_measure", "SubmitDate_fk");

    $STATE_FK = PjCLib->getPhysicalFieldDbName("defect_measure", "state_fk");

    $DAYSOPEN_FIELD = PjCLib->getPhysicalFieldDbName("DaysOpen_Dim", "Days Open");

    $SUBMITDATE_NAME_FIELD = PjCLib->getPhysicalFieldDbName("SubmitDate", "SubmitDate_name");

    $SUBMITDATE_DAYNUM_FIELD = PjCLib->getPhysicalFieldDbName("SubmitDate", "SubmitDate_daynum");

    $COLLECTIONDATE_NAME_FIELD = PjCLib->getPhysicalFieldDbName("collectiondate", "collectiondate_name");

    $STATE_FIELD = PjCLib->getPhysicalFieldDbName("state_dim", "state"); 

	17.3.6 
	For each defect, you must determine the difference between the submit date and the current date (collection day).  To calculate this, use the “daynum” attribute in the time dimensions.  The “daynum” is the running day count since the “start date” you specified when you populated the time dimension, So, if submit dates start at “2000-01-01,” and a defect was submitted on “2001-12-15”, the submitdate_daynum attribute for that defect will be 716.   If the current date is “2002-04-03” then the daynum attribute is 825.

Given these two “daynum” attribute values, the number of days the defect has been open is 825 minus 716, or 109 days.

	17.3.7 
	Get the daynum for today’s date (day of the collection).
	To get the daynum for today’s date, you must use an SQL query on the submitdate table.  Use the variable $currentDate in the filter.  The query should be constructed as follows:

SELECT $SUBMITDATE_DAYNUM_FIELD FROM $SUBMDATE_TABLE  WHERE $SUBMITDATE_NAME_FIELD='$currentDate'

Execute the query using the Rational ClearQuest API $session->BuildSQLQuery().

The daynum for today’s date will be stored in $currentDayNum.

Note Rather than typing this code segment, you can copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.
	# Get submitdate_daynum for today's date ($currentDate).  We will subtract the

#defect's submitdate_daynum to get the number of #days open.

$queryStr = "SELECT $SUBMITDATE_DAYNUM_FIELD FROM $SUBMDATE_TABLE  " .

      "WHERE SUBMITDATE_NAME_FIELD='$currentDate'";

#print "Execute query:\n";

#print "$queryStr...\n";

my $resultSetObj = $session->BuildSQLQuery($queryStr);

$resultSetObj->Execute();

if ($resultSetObj->MoveNext() == $CQPerlExt::CQ_SUCCESS) {

    $currentDayNum = $resultSetObj->GetColumnValue(1);

   #print "currentDayNum = $currentDayNum\n";

} 

else {

   print "ERROR: Could not get currentDayNum!\n";

   return;

}

	17.3.8 
	Get the defect dbid and submitdate daynum for each collected defect (today’s collection).

The dbid is used to iterate through the defect measures, which you will update with the ‘Days Open’ attribute.  The submitdate_daynum is used to calculate the number of days the defect has been open.
	The following is a sample query (without using the table and field name constant variables):

SELECT defect.dbid,submitdate.submitdate_daynum 

FROM defect,submitdate

WHERE (defect.collectiondate_fk=(SELECT collectiondate.dbid FROM collectiondate 
WHERE collectiondate.collectiondate_name='2002-03-19') and

       defect.submitdate_fk=submitdate.dbid and 
       defect.state_fk in (select dbid from state_dim where state in ('Opened','Submitted','Assigned','Resolved')))      

	17.3.9 
	
	Use the following query code (using the table and field name constant variables) in the Perl script:

SELECT $DEFECT_TABLE.dbid,$SUBMDATE_TABLE.$SUBMITDATE_DAYNUM_FIELD 

FROM $DEFECT_TABLE,$SUBMDATE_TABLE 

WHERE ($DEFECT_TABLE.$COLLECTIONDATE_FK=(SELECT $COLLECTIONDATE_TABLE.dbid FROM $COLLECTIONDATE_TABLE 
WHERE $COLLECTIONDATE_TABLE.$COLLECTIONDATE_NAME_FIELD='$currentDate') and 

      $DEFECT_TABLE.$SUBMITDATE_FK=$SUBMDATE_TABLE.dbid and 

      $DEFECT_TABLE.$STATE_FK in ((select dbid from $STATE_TABLE where $STATE_FIELD in ('Opened', 'Submitted', 'Assigned', 'Resolved')))                    

	17.3.10 
	
	The actual code using Rational ClearQuest API to execute the query is as follows:

[image: image18.png]§queryStr = "SELECT $DEFECT TABLE.dbid, § SUBMDATE_TABLE. § SUBMITDATE_DAYNUM_FIELD " .

“FROM §DEFECT_TABLE, § SUBMDATE_TABLE " .

“WHERE (DEFECT_TABLE. § COLLECTLONDATE I
" (SELECT §COLLECTIONDATE_TABLE. dbid * .
" FROM §COLLECTIONDATE_TABLE " .
“ VHERE §COLLECTLONDATE_TABLE. §COLLECTIONDATE_NAME_FIELD='§currentDate'] and
 §DEFECT_TABLE. §SUBNITDATE_FK=§SUBMDATE_TABLE.dbid and " .
" §DEFECT_TABLE.§STATE_FK in (SELECT dbid FRON §STATE_TABLE " .
- ERE §STATE_FIELD in ('Opened,'Submitted’,'Assigned, 'Resolved')))";

#print “Executing query:\n';
#prine “squerySerimn’;

my §resultSectbi = §session->BuildSQLQuery(squerySer);
$resultSetObi->Execute (] ;




Note Rather than typing this code segment, you can copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.

	17.3.11 
	Iterate through the defects returned, calculate the number of days open, and then update the defect record using the dbid.
	Using the Rational ClearQuest API:

· Loop through the results returned by the query.

· Get the dbid from the first column.

· Get the submitdate_daynum from the second column.

· Calculate the difference between submitdate and today’s date.

· Update the defect record (call the subroutine updateDaysOpen()).
Note Rather than typing this code segment, you can copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.
	[image: image19.png]vhile (§resultSetObj->MoveNext() == §CQPerlExt::CQ_SUCCESS) {
§dbid = §resultSetb)->GetColumnValue (L) ;
4oubmitdare_dayum = §resultier0h)->GetfolumValue (2) ;

# The difference betveen the subnitdate's daynun and the current date's daynun is
# is the number of days open!
§numbaysOpen = §currentbaylum - §subnitdate_daynun;

updateDaysOpen(§dbid, §numDaysopen) ;
scounti+,

)

print “§oount Change Request measures were updated.\n";

¥

]
\ # end subroutine myMain(]





	17.3.12 
	
	The subroutine updateDaysOpen() assigns a ‘Days Open’ dimension value for the defect.

If the number of days open is less than 15, the dimension value is “1: < 15 days.”

If the number of days open is 16-30 days, the dimension value is “2: 16-30 days.”

If the number of days open is 31-45 days, the dimension value is “3: 31-45 days.”

If the number of days open is 46-60 days, the dimension value is “4: 46-60 days.”

If the number of days open is 61-90- days, the dimension value is “5: 61-90 days.”

If the number of days open is 91-180 days, the dimension value is “6: 91-180 days.”

If the number of days open is 181-360 days, the dimension value is “7: 181-360 days.”

If the number of days open exceeds 360 days, the dimension value is “8: 360+ days.”

Note  The prefixes (‘1:,’ ‘2:,’ and so on) are included so that the values are sorted on the charts in the Dashboard.

Note Rather than typing this code, you can copy and paste it from InstallDir\bin\calculateDaysOpen.pl.
	[image: image20.png]jub updatenaysopen()
my ($dbid, Sdaysopen,) = @_;

# $daysopenstr is prefixed by a number so that they show up

# sorted on the bashboard distribution chart.

I (3cdaysopen < 15) {

Sdaysopenstr = "I: <15 days”

151 (($daysopen > 15) && ($daysopen <= 303) {
$daysopenstr = "2: 16-30 days”

151 (($daysopen > 30) & (bdaysopen <= 45)) {
$daysopenstr = "3: 31-45 days”

151 (($daysopened > 46) && (3daysopen <= 60 {
$daysopenStr = "4: 46-50 days”

151 (($daysopen > 61) & CbdaySopen <= 903) {
$daysopenstr = "5: 61-00 days”

151 (($daysopen > 91) & (bdlaysopen <= 180)) {
$daysopenstr = "6: 01-180 days"

151 (($daysopen > 181) &8 (Sdaysopen <= 360)) {
$daysopenstr = "7: 181-360 days”

&15iF($daysopen > 360) {
$daysopenstr = "8: 360+ days”






	17.3.13 
	Verify that the string value for the ‘Days Open’ field is in the DaysOpen_Dim dimension table.
	After you determine the string value for the ‘Days Open’ field, verify that the string value is present in the DaysOpen_Dim dimension table.  To update the defect_measure table, the referenced value must be defined first (this is a Rational ClearQuest requirement).

Note Rather than typing this code segment, you can copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.
	[image: image21.png]# Make sure the $daysOpenStr value is defined
# DaysOpen dimension teble. If it isn't, the
# value needs to be inserted. Otherwise, you cannot
# create a reference to it.
SaueryStr = "select dbid from §DAYSOPEN_TABLE "
"where $DATSOPEN_FIELD - '§daysOpenSer'":

my §resultset = §session->BuildSQLQuery|§ouerySer):

§resultsec—>Execute () ;

if (§resultSet->MoveNext() == §CQPerlExt::CQ _SUCCESS] (
# If the value is already defined in the table, then
# no need to do anything.

) else ¢
# do an INSERT
Sentity = §session->BuildEntity($DAYSOPEN TABLE):
§entity->SetFieldvValue (§DAYSOPEN_FIELD, §daysopenstr) ;
§retval = entity->Validate():
fentity->Comnit ()






	17.3.14 
	
	Use Rational ClearQuest API calls (GetEntityByDbid(), EditEntity(), and so on) to update the DaysOpen_fk  reference in the defect measure table.

Note Rather than typing this code segment, you can copy and paste the code from InstallDir\bin\calculateDaysOpen.pl.
	[image: image22.png]wy §entity = §session->GetEntityByDbId("defect”,

§session->EditEntity(fentity, modity"];
Sentity->SecFislavalue (§DAYSOPEN_FK, jdaysOpenstr);
§retval = fentity->Validave(l:

Sentity=>Commit (]

§dbid);

} # end subroutine updateDaysOpen()





	17.3.15 
	
	If you want to check your script, a completed script named calculateDaysOpen.pl is available in InstallDir\bin.  
	

	17.3.16 
	Save and close the file.
	Click File > Save.

Click File > Exit.
	


Part 4 –  Testing the transformation 

In this exercise, you will test the transformation by executing it from a command prompt.

	
	Use Case Steps
	Details
	Display

	17.4.1 
	Execute the calcDaysOpen.pl script.
	From the command prompt, execute the following script:

cqperl calcDaysOpen.pl


	[image: image23.png][Microsoft Windows 2000 [Uersion 5.00.21951
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c:\>cd program filesirationaliprojectconsolehin

[C:\Progran Files\Rational\ProjectConsole\bin>cqperl calcDaysOpen.pl






	17.4.2 
	
	Wait for the script run to finish.
	[image: image24.png][Microsoft Windows 2000 [Uersion 5.00.21951
<C> Copyright 1985-2080 Microsoft Corp-

c:\>cd program filesirationaliprojectconsolehin
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Part 5 –  Viewing the results

In this exercise, you will use the Rational ProjectConsole Dashboard to view the results of your transformation test.
	
	Use Case Steps
	Details
	Display

	17.5.1 
	From the main Rational ProjectConsole Web site, start the Dashboard.
	On the Rational ProjectConsole Operations toolbar, click Dashboard.
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	17.5.2 
	
	The Dashboard starts in a new browser window.
	[image: image26.png]‘A Rational ProjectConsole Dashboard - Microsoft Internet Explorer






	17.5.3 
	Create a new folder.
	In the Dashboard navigation tree:

Expand ClassicsCD.com Projects.

Click ClassicsCD.com Projects.

Right-click ClassicsCD.com Projects, and click New Folder.
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	17.5.4 
	Rename the new folder.
	The New Folder (1) node is added under ClassicsCD.com Projects.

Right-click New Folder (1), and click Rename on the shortcut menu.

In the now active label box, select the default text, type “Tutorial,” and press Enter.
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	17.5.5 
	Add a metrics panel to the folder.
	In the navigation tree, right-click Tutorial, and  click New Metrics Panel.
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	17.5.6 
	
	A new metrics panel window is displayed in the right pane.
	[image: image30.png]| File Edit View Favorites Tools Help

File Edit View Insen Window Help

IR EEEIMEEK]

Dashboard
=1/ ClassiesCD.com Projects
00 000 - A1 Project Status

] e






	17.5.7 
	Add a chart to the metrics panel.
	Click Insert > Chart.
	

	17.5.8 
	Specify the chart properties.
	In the Chart Type list, select Distribution.

Under Available Fields:

· In the Y-Axis list, select defect_count.

· In the X-Axis list, select Days Open.

To generate the chart, click OK.
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	17.5.9 
	View the chart

Note  Because the data displayed on the chart depends on the current date, your results will look different than what you see illustrated here.
	The new distribution chart is displayed in the metrics panel. It shows the number of defects based on the number of days they’ve been open.

The x axis of the chart displays three values: 6: 91-180 days, 7: 181-360 days and NULL.

The NULL defects represent “Closed” defects.
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	17.5.10 
	Enlarge the chart.
	In the lower right corner of the chart, drag the crosshairs down and to the right to make the chart larger.
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	17.5.11 
	Close the Dashboard.
	On your Web browser File menu, click Close.

If you are running Microsoft Internet Explorer, you will be prompted to confirm that you want to navigate away from this page.

Click OK.
	


Part 6 –  Adding the transformation as a shutdown command

Now that you’ve tested the transformation and viewed the results, you will add the transformation to the defect collection task as a shutdown command.  After you do this, the transformation runs at the end of each run of this collection task.

	17.6.1 
	Use Case Steps
	Details
	Display

	17.6.2 
	From the main Rational ProjectConsole Web site, start the Designer.
	On the Rational ProjectConsole Operations toolbar, click Designer. 
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	17.6.3 
	
	The Designer starts up in a new Web browser window.
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	17.6.4 
	Open the defect_collection [Task].
	In the Designer navigation tree, expand Scheduled Tasks, and click defect_collection.

Click the Parameters tab.
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	17.6.5 
	Add the calcDaysOpen.pl Perl script as a shutdown command.

Save the task and close the Designer.
	In the Shutdown Commands box, type “cqperl calcDaysOpen.pl.”

On the Designer File menu, click Save.

On your Web browser File menu, click Close.
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Conclusion

You have successfully created and run a transformation that produced a derived metric and viewed the results in a chart.  
Here’s what you did: 

· Learned what kind of transformation is required to determine the number of defects open for several different time intervals.  You learned that a data transformation is needed after defect data is collected to derive the ‘Days Open’ attribute, which is not collected from the source defect database.

· Wrote the transformation using the Rational ClearQuest API.

· Determined that to calculate the number of days a defect has been open, you must collect the defect submit date. 
· Determined that the ‘Days Open’ attribute is another dimension to the existing defect measure table.  

· Ran the defect collection.

· Created and manually tested the transformation that calculated the number of days a defect has been open.  This transformation processed the collected defect data (for the executed defect collection task).

· Used the Dashboard to view the results of the transformation test.

· Added the transformation to the collection task as a shutdown command.
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